BREEZESUITE™ 8.5
Release &
Installation Notice
BreezeSuite version 8.5 is the latest version of software available for the Medical Graphics’ Platinum
Elite™ Series, Elite™ Series, Ultima™ Series, and CPFS/D™USB systems.
CAUTIONS & WARNINGS
► IMPORTANT SYSTEM INSTALLATION NOTE: Medical Graphics USB Device must be powered on and the USB
Device driver must be installed prior to configuring BreezeSuite for first time use. Failure to follow these directions may
result in BreezeSuite configuration and diagnostic testing failure.
► NOTE: New Installation of BreezeSuite 8.5 or upgrade from BreezeSuite 6.4.1 or 7.x requires an access code (CD Key) that
must be obtained from Customer Service during the software installation. Customer Service is available Monday – Friday 7a.m. to
6p.m. (Central Time) by calling (1-800-333-4137). International customers should contact their local MGC Diagnostics Business
Partner. (see upgrade note below)
► Installing BreezeSuite 8.5 on a computer with Windows 7, 8/8.1 or 10 operating system that is controlling a Platinum Elite with
a part number that ends with -001 requires a hardware upgrade to the Platinum Elite. Without the hardware upgrade, the Platinum
Elite will not function properly. Contact your local sales representative or Technical Support for information on upgrading the
Platinum Elite.
►BreezeSuite 8.5 does not support:
●Gas & Flow Module Systems (CPX/D, CCM/D, CardiO2 & CPFS/D)
●VO2000, Profiler, PF/DX, 1085D Series or SpiroCard
●Elite Series Plethysmographs with model numbers ending in -001 thru -005
●Ultima Series with model numbers ending in -001 thru -005 unless noted with a label indicating system
been upgraded to -006 compatibility
●Microsoft Access Reports (“Reports” menu). Use of Quick Print reports is required
●Physician Review - This functionality has been added to BreezeSuite with a new “Review” button in
BreezeSuite (Breeze Review).
●BreezeLink HL7 (Link Medical interface)
●CPFS/D spirometer with model numbers ending in -001 & -002.

has

► Upgrading to BreezeSuite 8.5 is only supported from the following BreezeSuite versions: BreezeSuite 7.2 SP7 and BreezeSuite
8.0 or higher.
►Upgrading to BreezeSuite 8.5 automatically updates the workstation computer to Microsoft SQL 2008 R2 Express, or Microsoft
SQL 2014 on Windows 10 computers. Windows 7 computers must have Windows Service Pack 1 installed.
WARNINGS:

BreezeSuite 8.5 will not install on a Windows XP computer.
BreezeSuite WebReview is no longer supported in BreezeSuite 8.5.

►BreezeSuite 8.x added a higher level of security to meet HIPAA/HITech security requirements. All previously entered
passwords (from versions prior to BreezeSuite 8.0) will be reset and require the configuration of a new temporary password by
your designated security administrator prior to users accessing BreezeSuite 8.5. See the Security Administrators Guide located
with the installation instructions on the BreezeSuite 8.5 Flash Drive for additional information.
►GLI 2012 is the default predicted author for spirometry on all new software installations. Installing BreezeSuite on top of an
existing installation will not change the previously selected predicted authors.
►Medical Graphics does not have a “back-door” to the BreezeSuite application security feature. If you create a password
and the password is forgotten or lost, access to your patient data will be denied.
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Medical Graphics recommends BreezeSuite cardiorespiratory diagnostic software version 8.5 be installed by a
qualified service or support technician. Contact Technical Support by calling 800-333-4137 to discuss the
professional service option that best suits your facilities needs.
Because of the upgrade to Microsoft SQL 2008 R2 Express and possible changing of user passwords, it is
recommended that someone from your facilities IT department or system administrator be available during the
installation of BreezeSuite 8.5 software.

System Specifications and Prerequisites: For complete listing, see Installation Instructions available on
BreezeSuite 8.5 installation Flash Drive.

SYSTEM SPECIFICATIONS FOR WORKSTATION COMPUTER
Operating System

Windows 7 Professional with SP1
Windows 7 Ultimate with SP1
Windows 8/8.1 Professional
Windows 10 Professional

Processor

Pentium IV 2.8 GHz or Greater Minimum
Intel Core Duo or Greater Recommended

Hard Disk

40 GB Minimum
80+ GB Recommended

Memory

1 GB Minimum
3+ GB Recommended

Windows Display Properties

1024 x 768 Minimum Resolution

Other Hardware

3+ USB Ports
8+ USB Ports for Ultima Series Gx Systems

System Type

x86 (32-Bit) and x64 (64-Bit) PC hardware and
operating systems are supported.
NOTE: Ultima™ CardiO2 X-Scribe 3.x gas exchange analysis systems DO NOT support x 64 (64-bit) operating
systems.

Installation Instructions:
Place the USB Flash Drive into the computer. Using Windows Explorer, browse to the flash drive and run
(double click on) the “Launch.exe” file. Select Install Software, then Installation Instructions. The
Installation Instructions can be printed from the Flash Drive. NOTE: The installation instructions are in
PDF format. If Adobe Reader is not installed on the computer, select Install Software, then Adobe Reader
to install Adobe.
Translations: The translation files for Portuguese, French, Chinese and Spanish are included on this
Flash Drive.
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Highlighted Changes from BreezeSuite 8.0 to BreezeSuite 8.1


Corrected issue of not being able to advance the Review Status by more than one increment.



Added PC value to BRP Trend Tab in Breeze Review



Increased the font size of the PC value in the BRP Graph



Corrected ISO Volume correction alignment in FVC graph when aligning flow/volume loop to Residual
Volume



Corrected calculation of PC value when subject responded to first stage of bronchial provocation challenge



Corrected issue to retain graph properties in Breeze Review



Corrected issue of not being able to access exercise statement dictionaries



Added the ability to change the decimal places for Dose, Does Units and CDUs in the Final Report



Added ability in DBTools to sort by date when viewing an import list of visits



Corrected issues of an RTD system not displaying the DLco RTD Tab



Enlarged the font of the words Inject and Withdraw in the flow calibration screen



Added Gx variables VO2/VE & VCO2/VE



Added 9 Panel Graphs to Breeze Review



Added ability to delete patient visits from Query Database while deleting them from the central
BreezeSuite database



Added ability to Delete patient visits from DBTools when exporting visits



Added the ability to type in more than one letter in order to go to a physician in the list for Referring,
Reviewing or Pulmonary physician



Added a delay when double clicking on the “Recovery” button in Gx testing to prevent from going
immediately to stopping the test by mistake



Corrected MFC Application Error when switching from one test tab to another



Improved the installation of a Multi-user Server Upgrade



The Order Modified Date value is now included in the Export/Import file



Added the Order ID to the exported SUM file



Updated equations for Carbohydrate gm/day and Fat gm/day



Corrected MFC Application Error with Security option turned off and selecting to list patients as Visits



Corrected issue of converting SensorMedics CPX data



Corrected rounding of values between PDF file and SUM file



Add the ability to batch export PDFs or Sum files after all patients have been reviewed in Breeze Review,
rather than after each individual patient’s review was complete

Highlighted Changes from BreezeSuite 8.1 to BreezeSuite 8.2


Added support for redesigned Ultima Series



Added support to function on a Windows 8/8.1 computer



Added a function to automatically flush the DLco gas on a Platinum Elite DL system if it has been at least
4 hours since the last flush



Added the ability to open an existing visit that has one or more “Orders” assigned via: Orders Dialog
button, Open Patient dialog and Open Visit dialog
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Corrected an issue where the system was sending a message to the database every 10 seconds. This caused
intermittent communication errors or flow trace stuttering during flow calibration



Added the ability in the Post Test Comments dialog for the technician to select which PDF report to export
in Breeze Review



Added the ability to have a shared folder listed as the export directory for exported files



Corrected an issue in Breeze Review where the time variables were being rounded instead of using the
actual time in minutes and seconds



Added the ability to have ICD-10 Code, description and Group Code to the Diagnosis dialog



PF Trend and GX trend now support local date settings such as “dd/mm/yyy”



Changed the REE Kcal/day and Adjusted REE to use the same averaging settings



Added ability to export Trend Reports through Web Review



Corrected issue of receiving an error message in BreezeSuite after exporting visits from Breeze Web
Review



In Pulmonary Custom Consult, corrected an error when trying to create a rule based on Sex or Race



Added Exercise Oscillatory Ventilation (EOV) Tab and functionality in the GX Tabs



Added Doctor IDs 1,2 & 3 (Referring Doctor, Reviewing Doctor & Pulmonary Doctor) as well as
Technician ID, Diagnosis, Account #, Room #, Comments and Medication to the Order Table when
receiving Orders from hospital EMR



Updated the Patient Query Option to function with SQL 2012



Enhanced the conversion of SensorMedics data into BreezeSuite



Corrected the issue of the BRP Trend view not updating when only ABG values are entered in different
stages



In Breeze Review Trend Tab, added the ability to sort by Visit date (ascending or descending)



Added the ability to view the calibration log when no hardware or system is attached to the computer by
going to: File>Open>Calibration Logs and Reports



Corrected the issue where physician interpretation was appearing before the technician comments in a
configuration of PF Pages when both were selected. PF Pages now puts the physician interpretation after
the technician comments



Corrected the issue of not being able to change the X Axis properties in the Window Tab of Gx testing



Corrected issue of not being able to select visits in the Trend Tab of Breeze Review



Corrected issue of font size reducing after printing or previewing the BRP Trend page



Added ability to perform Hypercapnic and Hypoxic P100 studies on an Ultima PFx Tab 6



Corrected issue of the text report name not being entered into the HIS Sum file when exported from Web
Review



Corrected issue when using the NICO or Exercise Flow Volume Loop Options where the External
Deadspace in the Settings Tab would switch to zero

Highlighted Changes from BreezeSuite 8.2 to BreezeSuite 8.3


Added support for Windows 10 and SQL 2014



Added ability to export to multiple locations. The Export/Import Tab has been separated into two tabs. The
Export Tab now contains a spreadsheet that allows the user to set up auto export for PDF report, Text
report, COW files, HIS (SUM) files and HLF export (if turned on)



Added 4 Review Status selections to the drop down list: Amended Review (indicates a test is being
amended and reviewed), Amended+Posted+Locked (reapplies electronic signature if active, locks the study
and posts the results), Corrected Review (indicates a test is being corrected and reviewed),
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Corrected+Posted+Locked (reapplies electronic signature if active, locks the study and posts the results)


When merging to the Shared database, the software will allow the operator to choose whether or not to
merge the PF Predicted Set, Gx Predicted Set or Reports into the shared database.



Added an Alert Message to the Patient and Visit list dialogs when there are any pending export visits for
the current workstation. The operator can then view the list and export the tests.



Added the ability to prevent a user from adding a visit without going through the Orders screen. The Order
Tab in options has a checkbox that when checked, the “AddVisit” button on the Patient dialog screen is
disabled.



Improved the performance when reviewing multiple patients in Breeze Review.



Added the ability for users to assign and un-assign orders to multiple visits in BreezeSuite.



Corrected an issue where the Request Date Time column in the Order Entry dialog box did not sort
correctly.



Added “Second ID” and “Patient ID” to the Demographics Section of Breeze Review.



Corrected an issue of the ECG Summary report printing the treadmill report when a cycle test was
performed.



Enabled the Calibrate, Zero Flow and Gas AutoCal buttons after the user selects the “Restart” button.



When the user selects the “rebreathe” option for ventilator testing, the Breath Detect Mode automatically
switches to “flow only”.



If the user selects the Recovery button during Gx testing, the user will be asked to confirm.



Added the following data types to Query Database: LLN, ULN and SD. The user can query on these data
types.



Added support to import data from the Remon Pro FOT device into BreezeSuite. The user can also input
patient demographic data into BreezeSuite and send that data to the FOT so patient information does not
have to be entered twice.



The FOT variables are available in a final report as well as Trend Report and Trend Graph



Added the ability to plot “% Predicted” on the same Trend Graph as measured values



Added a Gx Time Down Tab in Breeze Review



Addressed the issue of communication with Mortara X-Scribe software during “ECG Only” testing which
caused loss of ECG data or lockups



Added support for the Ganshorn/CustoMed ECG Un-directional protocol



Added the ability to activate, deactivate or combine multiple staff members at a time without leaving the
“Open Staff” dialog.



Corrected print issue with AT Graph.



Corrected units conversion (SI to English) in Query Database.



Added the ability to have the Disability Report attached to the normal printing process. Users can insert the
Disability Report to the Print, Preview and Export functions.



Disabled the ability to go to the Pulmonary Consult Dictionary when Breeze Review has a patient visit
open



Added ability to “auto run” Post Test Comments and Pulmonary Consult when exporting text reports



Every other line in Trend Tab is now shaded for better visibility



Improved the performance when exporting multiple PDF reports



Improved performance when closing a patient visit after exporting a report that contained Trend data



Improved Race designation when converting Collins XML files into BreezeSuite



Added default graph properties for graphs in Breeze Review. Previously the user had to configure the graph
properties when using Breeze Review for the first time
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Improved the application of Filters when “Include patients with no visits” is selected



In Breeze Review, corrected an issue when inserting statements - after the 2nd inserted statement, the
period would not shift its’ position



Corrected the issue of Custom Consult truncating the “% Predicted” values



Corrected issue of Watts and RPM not being displayed when in Recovery phase



Added the ability to display the Aux Data fields in the Trend Tab of Breeze Review



Added 4 Text reports with Challenge or Stage columns



Corrected an issue where Pulmonary Consult would not appear on final report



Corrected issue of Trend report pages not displaying when previewing the report



Added the ability to perform Hypoxic and Hypercapnic P100 studies on a Ultima Tab 6



Corrected an issue when saving a test from the SVC Tab



Corrected an issue of not being able to go into Test Mode when “Include patients with no visits” is selected
in the Open Patient Screen



Added the ability to calculate Breathing Reserve (% and L/min) based on the Predicted Max VE calculation
as defined in the Gx Predicted Set



Corrected issue for fixed predicteds where the users settings were not being saved for: VE/VCO2 and
VE/VO2



Added a Consult Only Text report



Added default authors for VO2/VE & VCO2/VE predicteds



The Clear HIS Demographics menu in DBTools has been changed to Reset HIS Parameters. Selecting this
menu will bring up a Reset HIS Parameters dialog. User can check any combination of: “Reset
Demographic Parameters”, “Reset PF Test Parameters” or “Reset GX Test Parameters”.



Corrected an issue when switching between preVent Flow Sensor and Direct Connect Flow Sensor: The
calibration factors automatically update to the preVent Flow Sensor



Corrected an issue where the External Deadspace in the Setting Tab would intermittently switch to zero
when using the NICO or Exercise Flow Volume Loop options



Corrected issue in Breeze Review graph properties where changes would not save if the Security option
was not active



When a report is printed that has both the Interpretation and Post Test Comments active in the PF Pages
Configuration, the Post Test Comments now appear before the Interpretation. Previously the Post Test
Comments followed the Interpretation section.



Corrected the calculation of CHO (g/day) and Fat (g/day)



Improved the functionality of the “Find” button in the Batch Export Visits screen



When installing on a Citrix Server, BreezeSuite no longer requires a CD Key to install



Corrected an intermittent issue where the treadmill would go to 0.5 mph instead of zero when user selected
the “Stop Treadmill” button



Improved the speed of SUM file creation when exporting the SUM file




Improved software to identify and confirm the highest measured VO2 between the start of exercise and
start of recovery.
Improved functionality in Breeze Review when using the Select Visits option on the PF Trend graph



Corrected an issue where the “Review Mode Only” allowed users to access the Test Mode in Visit
Selection
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Highlighted Changes from BreezeSuite 8.3 to BreezeSuite 8.4


Added two new variables: VA/TLC(pleth) and VA/TLC(N2)



Added the ability to lock the Export fields within BreezeSuite via Security/Roles



PCx and Challenge/Max Response variables have been added to the variable list for SUM file export to
EMR



The visit order date for Trending visits in Breeze Review is based on the setting in the F5 Options Trend
Tab



Order IDs and Order Visit IDs have been added to the Open Patient/Visits screen as well as Breeze Review



The Order Visit ID is now displayed in the orders spreadsheet in the Visit Order Tab



Corrected issue of the LLN and ULN for GLI 2012 having a slight difference from the GLI website
calculator



Corrected issue within Protocol Log Tab when editing a Protocol



Added a “Reset Filters” button to the Open Patient and Open Visits dialog



Added the ability to print the list of authors from the PF Selected Author Set



Removed the use of the Tab Key when typing a Pulmonary or Exercise Consult



Added functionality for new face tent fan assembly



Added the ability to Lock the location of the BreezeSuite Toolbars and Reset the location of the Breeze
Review toolbars via View>Toolbars



Added a “Miller Non-Smoker” DLco predicted author which does not adjust the DLco predicted value
based on the patient’s smoking history



Added %Change for each variable in the BRP Tab in Breeze Review



Added %Change for each variable in the Trend tab in Breeze Review



Added functionality for Analog I/O Controller for redesigned Ultima CPX



Added the ability for BreezeSuite to be installed in a Citrix environment without the need of a local SQL
database



Pulmonary and Exercise Consults now wrap to the next page if there is not enough room on the current
page



Decreased the font size of the PC and Sensitivity label on the BRP Graph



Updated the audit trail to add additional fields



Active Directory is now integrated with BreezeSuite. Logging into Windows operating system can also log
you directly into BreezeSuite



In the Pulmonary and Exercise Consult options, user can select whether or not to include the physician
name in the consult dialog



Added OUES and VE/VCO2 Slope values to the SUM file export



Modified Gutierrez 2004 ratios to be whole numbers rather than having decimal places (80 vs .80)



Modified Gutierrez 2004 MIP predicted to be a negative value (original article had it a positive value)



Added Standard Deviation for Gutierrez 2004 MIP/MEP variables



Corrected issue in Breeze Review where custom reports with Test Views would cause MFC Application
errors



Corrected issue where the Peak Flow (FEFmax) value was not consistent with the graphic value on very
sharp peak flows



In the Workstation settings, added new entry for Distal Dead Space for adapters between the preVent flow
sensor and the patient circuit
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Corrected issue when switching back and forth from Local to Shared database.

Changes from 8.4 Service Packs


Updated text reports to include header and history section.



Corrected issue with clinical link between BreezeSuite and Welch Allyn CardioPerfect ECG
software.



Corrected issue with blank pages on a GX report.



Corrected issue with PF/GX trend data not updating in Breeze Review in between reviewing
patient visits.



Corrected issue with adjusting dead space values on GX scripts.



Improved interface between FOT and BreezeSuite.



Integration of X-Scribe 4.0 CPI (cardiopulmonary interface).



Corrected issues with active directory integration.



Corrected issues with FOT graphs and labeling.



Updated default FOT report and screen configuration graphs.



Corrected issue related to auto filters and staff login settings.



Corrected issue with Breeze Order Entry that allows users to cancel orders regardless of current
order status.



Corrected issue with ExFVL default graph configuration.



Corrected assert error issue indicating decrypted passwords do not exist in database if password
entries are different between local and shared database.



Corrected issue with External Device Calibration record when refreshing local database.



Corrected issues related to DBTools identifying active directory server based on domain.

Highlighted Changes from BreezeSuite 8.4 to BreezeSuite 8.5


Added the Lung Volume bar graph to Physician Review



Changed the Acceptability and Repeatability criteria for DLco testing to match the ATS/ERS 2017
Guidelines.



Added the 2017 ATS/ERS DLco Guidelines Test Quality Grading available in the DLco Test Screen &
Final Report.



Added new controls in the F5 Options dialog (General Tab) to change font size for the data tables in the
test screens and Breeze Review, as well as the font size for the printed report.



Added the ability to reselect Race entry when you open a patient visit, rather than having to go to Edit.



To improve database performance, changed BreezeSuite multi-user to only copy modified resources and
patients to the local database when logging in or out of BreezeSuite or switching to local mode.



Allow the user to remove or cancel multiple orders at one time.



Added a Z-Score graph to the Final Report and Breeze Review.



In the Final Report, added the ability to shade every other line to make the rows easier to read. This option
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is turned on in F5 Options – PF Pages Tab.


Added the ability to have ratios such as FEV1/FVC as either a decimal fraction or a whole number. This
option is configured in the F5 Options Units Tab.



Added a column for Volume Change from Pre-Bronchodilator to either Challenge or Post-Bronchodilator
stages. This option is available in the report column headers of PF Pages Tab.



Added Spirometry Test Quality Grading according to NLHEP and Spirxpert – user selectable in the F5
Options Menu – FVC Tab.



Added the ability to lock and unlock roles in Security.



Added the ability to Export/Import PF and Gx Predicted Sets in DBTools.



Created an Order Status Display filter for Open Patient list. This allows BreezeConnect users to restrict the
patient list to those patients that have orders with a specified status.



Added a “Technician Select Reports” role in Security Roles. This role determines if the user has the ability
to select a specific report for export in the Post test Comments dialog.



Corrected an intermittent issue where the ECG Only flag was getting set incorrectly on Gx tests.



Allow the user to expand the Post Test Comment dialog box.



Added the ability to view Billing Modifiers, Hospital Charge Code (CDM Code), Procedure Codes
(Professional CPT Code) and Diagnosis Codes (ICD-10 Codes) in Breeze Review.



The exported data file (SUM file) has been updated to include the above.



Corrected an issue with the legacy Ultima to allow face tent testing with the legacy fan assembly.



Corrected an issue with a blank page being inserted into the ExFVL report when only the graphs were
selected to be printed.



Added support for the Tab 004 CPFS/D spirometer.



Added an additional 80 Aux Data fields, which brings the total Aux Data fields to 100. Only the first 20
Aux Data Fields are checked to display by default. Additional fields can be activated in F5 Options - Visit
Tab.



Modified the calculations for % Change and % Predicted Change to be the same in terms of rounding to the
next number.



Resized the FOT graphs so that the dta table and graphs are on one page.



Added the Gutierrez 2004 predicted author for TGV. Previously it was on FRC(N2 Washout) only.



Changed the “Sensitivity” label on the bottom of the BRP Trend graphs to PD20.



Added a PD column to the BRP Trend Tab in the data table. This can also be printed in the Final Report.
The PC20 and PD20 are separate options in the F5 Options dialog of BRP Trend Tab.



Added CO Index (Direct Fick) variable.



Added CO (Direct Fick) VO2 Mean variable called: “CO DF VO2 Mean”.



BreezeSuite now displays a message recommending to perform a gas calibration immediately prior to
starting a gas exchange test. The message will appear if it has been over 5 minutes since the last gas
calibration.



Updated the derived Treadmill Watts equations.



Added the ability to have User Defined/Selected predicteds for HR Max. This is configured in the Selected
Author Tab of the GX Predicted Set.



Changed the method of determining Exercise Oscillatory Ventilation (EOV). BreezeSuite now uses the
average resting VE instead of resting VE amplitude.



Added the ability to interface with the Zephyr Heart Rate Monitor.



Added the variable VCO2/Flow



Added variable and tab for Chronotropic Index.
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When reopening an existing visit and going into a test tab, BreezeSuite will automatically display the
graphs of all selected efforts.



User authentication has been updated to allow for integration with Active Directory in both an automatic
and manual method. Users can be authenticated and logged into the BreezeSuite application automatically
based upon the Windows credentials of the hosting computer. The BreezeSuite application can also be
configured to ask the user for their Windows credentials which are then authenticated via Active Directory.
This update allows for all application user accounts to be managed at the domain level.
Disabled the File/Exit menu button when a patient visit is open in Breeze Review.




Corrected an issue where communication would drop out (watts & RPM) between the Ergoline ergometer
and the Ultima when a blood pressure measurement is taken.



Corrected an issue where Diagnosis entries could not be deleted.



Added an option to determine if the patient list should be refreshed every time the patient list is displayed.
This option is configured in F5 Options – Patient Tab.



Enhanced the search option when searching for a physician, technician or site name in the filter drop-down
box. Previously only able to type in the first letter. Enhanced to be able to type in multiple letters.



Updated the installation to install Microsoft SQL Server 2014 Express instead of SQL Server 2008.



Corrected an issue where audit changes to staff were not being tracked.



On systems entering new visits via “Orders” only, added the ability to manually enter a new visit for a
Syringe Study or Biologic QC Subject by unchecking “Add Visits via Orders Only” checkbox in F5
Options – Orders Tab.



Added a “Biologic QC Subject” checkbox on the patient dialog screen to designate this subject as a
Biological QC test.



Corrected issue of duplicate Staff entries when merging from Local to Shared database.



Added Order ID and Order Description to text report headers.



Added new text report, “Complete Report w/Post Pred”, that includes Post % Predicted.



Added the ability to make the Physician drop down entries a required field. This is set in F5 Options>Visit
Tab.



Corrected issue of graph settings when a second page was added to a report with the graphs on the side.



Added Exercise Consult to the report header options.



Corrected an issue where Order IDs were not getting deleted and are visible in the Patient Visit Tab.



Corrected an issue where the calibration factors for TcpCO2, Sweat and Body Temperature were not being
saved.



Increased the Order ID character length to 30 characters.



Corrected an issue where Orders were not staying assigned to patients with prior visits when navigating
between the previous visits prior to saving the changes.



Corrected an issue where the physicians name was duplicated on the PF and GX consults.



Created a “GX Other” Tab in Breeze Review for displaying OUES Slope, VE/VCO2 Slope, VO2 Work
Slope and Chronotropic Index.

Changes for BreezeSuite 8.5 Rev C


Added Digital Signature to installation files.

Changes for BreezeSuite 8.5 Rev D


Added Digital Signature to all all .EXE, .OCX and .DLL files.
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Changes for BreezeSuite 8.5 Rev E


Removed Digital Signatures on USB driver installation executables to correct installation issue on

Windows 10 operating systems.
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